CSCI 1100

Database Management Exercise

Part I: Movie review database.

1. This is an application we have discussed in the lecture part of this course. Users can enter movies, search for movies by genre, view reviews that users have entered, and enter their own movie reviews. Try it!
2. Launch Microsoft Access.  We’ll create a new blank database to start.  Go to the file button ([image: image24.png]Edit Relationships
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) and click New.  A blank database task pane shows up on the right side of the screen.  Save the database file as MovieReviews.accdb in your I drive and click ‘create’.  
The movie review system will keep track of two types of things: movies and reviews. In database parlance these are called entities. We will create two database tables, one for each entity.
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Before we put anything in our table, we need to design our table, i.e. name each column and define each column’s data type (a little more work than we are used to from Excel).  From the menu bar choose Create, then Table Design.
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Create the movie table with the details shown below. The following sets up the columns for our movie table.  
	Field Name
	Data Type
	Description

	id
	AutoNumber
	Creates a ‘hook’ into the table so that reviews can reference this movie via a foreign key.

	genre
	Text
	The movie genre such as drama, comedy, etc.

	title
	Text
	The movie title, such as “Pee-Wee’s Big Adventure”


4. Right-click on the id field and choose Primary Key. A primary key is necessary so that the review table can link to this one.
5. Click the Save icon, and name this table as Movie. It is good practice to name the table after the type of entity that is represented by each row of the table. [image: image3.png]MTable
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6. Use Create-> Table Design again to create another table, like this:

	Field
	Type
	Description

	movie_id
	Number
	The id of the movie for which this review is written

	reviewer
	Text
	Author of this review.

	review_text
	Memo
	The reviewer’s comments about this movie.


We use a Memo type field for the reviewer’s comments because the size of a Text field is limited to at most 255 characters. Note that we do not include the movie title, but instead use the movie_id field to link this table back to the movie table, where the title is stored. The movie_id field is called a foreign key, because it represents the key field in another table.

7. Save this table as review. Access may suggest that you provide a primary key so that other tables can link into this one. However there will be no other key to link into this table, so click No. 

8. Be sure to close these two tables before continuing to the next part.  To do so, click the X belonging to the table window as shown below.  Close both the Movie table and Review table.
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9. Now let’s inform Access about the foreign key relationship between these two tables. On the Access tool bar, click the Database Tools menu item and select Relationships in the Show/Hide group.
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10. Since we want to define a relationship between the movie table and the review table, we must select both tables to show in the relationships window. Select the movie table by double-clicking on it (or click it and select ‘Add’), and select the review table by double-clicking on it. Having selected both tables, click the Close button. [image: image6.png]Movie review




11. You should now see the designs of the two tables laid out side-by-side. To define the relationship, simply click and drag the id field from the movie table onto the movie_id field of the review table. At this point an Edit Relationship window should pop up.  Select the Enforce Relational Integrity option, and click Create to define a simple relationship (the id from the movie table equals the movie_id from the review table). This means that database operations that violate the relationship are now illegal. For example, you may not delete a movie for which there is a review. To do so would render the ‘movie_id’ field in the review record meaningless.

 You should now see a link drawn between the two tables. Note that the link is marked “one-to-infinity.” This means that each movie may be matched with an unlimited number of reviews, but each review is linked to a unique movie. [image: image7.png]Movie review





12. Close the Relationships window and save any changes.  You should get in the habit of closing and saving windows when you are not editing it.  Don’t close the entire database, only certain properties of it you are editing (i.e. close tables when you are not working on them).  You will run into less problems this way.

13. Let’s create a nice-looking input form for users to enter movies into the database. Click the Create menu item, then in the Forms group, select More Forms then Form Wizard.  In the middle of the window, you will see a Table/Queries dropdown list.  This allows you to choose the table or query where the object’s data comes from. Since this form will put data into the movie table, select Table:Movie. Use the double-arrow to move all the fields from movie into the form.  Click ‘Next’, and in the following steps, choose a columnar layout and the Northwind style. Name your form Movie_Entry and select Open the form to view or enter information and click Finish.  You transition from one field to the next with the Tab key. Notice that the id field initially comes up saying (New), but changes into sequential id numbers as you enter data (since we selected ‘Autonumber’, do not enter in an id yourself, let Access do that).  Use your newly created form to enter some movies (at least 5 of your favorite movies).  To make a new record, in the last field (the title field) hit Tab OR you can select the new record button at the bottom of the form (see below).
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14.  Now let’s try customizing this form.  Currently we are in Form View, allowing us to use the form and enter data.  To edit the form itself, we need to be in Design View.  There are several ways you can change the view:
a. In the Home tab, in the top, far left side, you should see a View button.  Click the View down list arrow to select Design View. [image: image9.png](@) @2 o - MovieReviews :
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b. Alternatively, notice in the bottom right-hand corner of your window you see three icons, [image: image10.png]Num Lock




.  Click the far right icon to open the form in Design View, so that we can make changes to the design.  Alternatively, you can right click on the Movie_Entry tab at the top and select Design View that way.
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15.  Now in design view, you will see the form has three parts: “Header,” “Detail,” and “Footer.” 
16. Select the boring title “Movie_Entry” in the Form Header and delete it.  Form Design Tools should be available on your toolbar, and the Design tab should already be selected.  Click on the label icon [image: image12.png]Form Design Tools MovieReviews : Database (Access 20
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in the Controls group and insert a label into the Header area. Draw out a label and type in “Ben’s Movie Review Club”. Use your name instead of Ben.  Click off of the new label after you have typed in the title.  We will format it below.
17. We can format the label. Options are available if you Right-click on the label and choose the Properties menu item. Experiment with some of the formatting properties in the Font group. Here I have changed the fill/background color, font color, font family, font size, and made it bold and italic. Change your title to your liking so that it looks more dramatic.  [image: image14.png]# Form Header
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18. A moment’s thought should convince you that we really don’t need the user to enter the id field, since this field is auto-generated by the software. Right-click on the “id” label and choose Cut.  Select one of the two remaining fields and a crosshairs icon should pop up next to it.  Grab the crosshairs icon and drag the two fields down slightly to give us a little more room.  Now, in the space left, insert a new label saying: “Please enter the movie details.” [image: image15.png]# Form Header
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19. Select the text on the other two labels and change them to “Movie genre” and “Movie Title.” Now you should have something more or less like the form shown below.  [image: image16.png]# Form Header
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20. Use one of the view changing methods we learned before to change the view back to Form View. Now you can enter a few more movies.
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Queries (i.e. ask your database a question)

21. Now we’d like to get some information out of the movie reviews database. Click the Create tab, and then in the Other group, select Query Design.
22.  A dialog box will pop up from which you must first select the tables to be part of our query. Our first query will involve only the Movie table, so click Movie, then Add, then Close. 
23. You should now see a design grid as is shown below. The first row had the label “Field” next to it.  We’ll use this to select which column(s) of our table we are interested in getting information from.  Click in the first “Field” box and select genre. Then click in the second “Field” box and select title, as shown here. [image: image18.png]Field:
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24. Now use the view icons at the bottom of the window to switch the query to Datasheet view. 
25. You should now see a list of all the movies and their genres. Note that the ID field is not shown, because we do not need to see it. Save this query as Find Movies.
26. Query Criteria: Use your Movie_Entry form to insert a drama movie into your Movies table if there is not one there already. Alter the Find Movies query by inserting the word Drama into the Criteria field in the genre column. Now look at your query in Datasheet view. [image: image19.png]Num Lock




 Now you should see only drama movies listed.

24. Use the Movie insert form to insert two Adventure movies into your Movie table if there are none there already. Now select the Find Movies query and view it in Design view. Modify the Find Movies query to display all Adventure Movies. Check by viewing the query in Datasheet view.

25. Can we modify the Find Movies query to display all Drama and Adventure movies? Change to Design view.  In the Criteria area at the bottom of the genre column, use the or  feature. Enter Drama in one line and Adventure in the or: field.  Check by viewing the query in Datasheet view.

26. This exercise illustrates an important feature of queries: the criterion is checked separately for each record. We wanted all Drama movies and all Adventure movies; this means that the genre of each movie is either Drama or Adventure.
27. Before we go on, we need to add some movie reviews to our Review table.  Often a form is the clearest way to enter data into a table, so let’s create a form to enter reviews.  
28. Click the Create tab, then More Forms, then  Form Wizard. If you need help, check back to step 13.  You will NEED to select the ‘review_text’ and ‘reviewer’ fields from Table:Review and ‘title’ from Table:Movie.  When asked “How do you want to view your data?” select by movie and Form with subforms.  I find ‘tabular’ layout for the subform to be helpful, but you can experiment with other designs if you’d like.  Choose any style you’d like.  Give it the name, Review Entry Form (you can leave the subform name as the default).  Once you finish your form, use it to enter a few reviews for your movies (you’ll need a review for a drama movie, so add one in now if you don’t have one).
29. Join queries: Now we would like to see a list of all the movie reviews, with the reviewer names and the movie titles. This means we will need information from both the Review table (the reviewer name and comments about the movie) and the Movie table (the genre and title of the movie). When data from two or more tables are used, we call this a join query.
30. First, let’s see what happens when we get rid of our relationship between the tables.  Go back to Database Tools and Relationships.  Click the link between the two tables (it will get bold when you select it) and press delete.  Now close the relationship window and save it.
Now Create a query in design view (Create->Other group->Query Design).  The pop-up box comes up asking you which tables will be used. This time, click Movie and then Add; then click Review and click Add.
Choose the following fields in the first four columns:

Movie.genre

Movie.title

Review.reviewer

Review.review_text
31. Now view the query in Datasheet view [image: image20.png]


. Yikes! There are way too many reviews! If you look closely you will see that the query is matching up each review with every movie, which is wrong. Thus you see the benefit of creating a relationship between the tables.  One way to fix it is to add the relationship back in, or another way to fix this is with SQL, Structured Query Language (we’ll do the latter).

32. Change the view to SQL View. 
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You will now see a text version of this query. Delete the semicolon (;) and add the following line to the bottom of the query:

WHERE Movie.id = Review.movie_id;
33. A WHERE clause cuts down the result of a query by only allowing results that satisfy the WHERE condition. In this case, the condition says that the movie must match the review (they have the same id). Check the result by viewing the query in Datasheet view.

34. If you haven’t already, add a review for one of your drama movies. Next, let's modify the query to see all reviews for Drama movies. Add the following line to the end of the query inside the semicolon (keeping the previous where clause):

AND genre = 'drama'

Don't forget the quotes! Go back to Datasheet view  – this time you should see all the reviews for Drama movies.  Do you see the purpose of a query?  We asked it in a specific way to display all our drama movie reviews, and it responded by listing them.  Pretty neat.
35. Now we will learn how to create data tables by file import. Click the Save icon and then close the Movie Review database by clicking the File button and click close database.  
36. Now use the File menu to create a new, blank database named Football Season. We need a new database because a database should be a collection of tables with a common theme. Instead of designing the tables ourselves, we will create them by importing table-structured data from an Excel database.

37. Go back to http://cs.uga.edu/~rwr/CS1100/labs.html and download the file FootballSeason.xlsx. This file contains two worksheets (check the tabs at the bottom), Teams and Games, about the 2007 UGA Football season.

38. Open FootballSeason.xlsx and take a look at the two worksheets, the columns, and the values they contain.
39. Now close the Excel file before going on.  
40. In Access, click the External Data tab, and then in the Import group, choose Excel.  Click browse choose FootballSeason.xlsx and select Import the source data into a new table in the current database and then click OK.  We’ll need to do this process twice to import both worksheets, but that’s OK.  
a. First select the Teams worksheet.  Then click Next.
b. Click the checkbox for “First Row Contains Column Headings” then Next.
c. Click Next again.
d. Select “No primary key” then Next.

e. Keep the Teams name and click Finish. 

f. (You don’t need to save the import steps)
41. Now we will use the same technique to create a table from the Games worksheet. 
More SQL queries: OK, now let's practice some SQL queries. 
When creating SQL queries from scratch, we’ll need a blank SQL Query window.  Here’s how to get one:

1. Click on Create->Other group->Query Design.  

2. Don’t add any tables and click ‘close’.  
3. Choose SQL View. 
4. Presto.

Try the following queries and save each query with a different name (be as creative or uncreative as you want in your naming, as long as you end up with 8 different queries).  After each query, switch to Datasheet View to view the results of your query.
*Helpful hint:  to make sure you get the column names correct, open up the Teams and Games tables and glance at them as you’re making these queries.
1. SELECT home_team, visiting_team, game_date

FROM Games
WHERE visiting_team='UGA'

--this should give you all the Georgia away games for the season

2. Compose a new query for all the Georgia home games for the 2007 season (hint: at all home games, UGA is the home_team).

3. Compose a new query for all the home games that Georgia won last season. Hint: Add another line starting with AND with the condition that the home team won (i.e. home_score > visitor_score)

4. Compose a new query  for all the away games that Georgia won last season
5. Compose a new query for all the away games that Georgia lost last season.

6. Compose a new query for all the games that Georgia won last season. This is a tough one! The first half of the WHERE condition looks like this (you fill in the ‘???’ half):

WHERE (home_team='UGA' AND home_score>visitor_score) OR (???)

 Hint: notice that the first AND block in parentheses describes a home game won by Georgia. Replace the question marks inside the parentheses to describe an away game won by Georgia. The combination of these two will yield all games won by Georgia.

7. Compose a query for all the Georgia home games, but this time display the Team and the Mascot instead of just the team abbreviation. The outline of the query is:

SELECT fields you want to display, separated by commas

FROM tables you need, separated by commas

WHERE this is a Georgia home game

AND the visiting team in the Game table matches the team abbreviation in the Team table
-- replace the italicized text above to get the correct query.  The result of this query is a Join query as we learned about earlier.
8. Similarly, compose an expanded list (Team + Mascot) of all Georgia away games.

